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1

Introduction 1

This chapter describes the features and functions of PATROL Adapter for 
Microsoft Office.

About PATROL Adapter for Microsoft Office  . . . . . . . . . . . . . . . . . 1-2
Reporting Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
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Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
Supported Platforms  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
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About PATROL Adapter for Microsoft Office
PATROL Adapter for Microsoft Office is a COM server that allows you 
to connect to a PATROL Agent and gather information without a 
PATROL Console. 

Reporting Tools

PATROL Adapter for Microsoft Office provides reporting capabilities for 
the PATROL Agent. The PATROL Adapter for Microsoft Office Report 
Wizard and Report Generator Utility use the PATROL Adapter for 
Microsoft Office COM server to collect data from PATROL parameters. 
Using the PATROL Adapter for Microsoft Office, you can evaluate 
PATROL data using Microsoft Office products. 

No PATROL Console Needed

You do not need PATROL Console or PATROL Agent installed on your 
machine to use PATROL Adapter for Microsoft Office. PATROL Adapter 
for Microsoft Office gathers information by connecting to a PATROL 
Agent via the PATROL Event Manager API on hosts that you select.You 
must have Microsoft Excel installed to save and display reports.

PATROL Adapter for Microsoft Office includes these components:

• PATROL Report Wizard

The PATROL Adapter for Microsoft Office Report Wizard guides 
you through choosing hosts, data types, data schedules, and report 
types to create reports in Microsoft Excel. Once you generate reports 
in Microsoft Excel, you can export the report to Microsoft Word to 
HTML, or to Microsoft PowerPoint as a presentation.
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• PATROL Report Generator Utility

The PATROL Report Generator Utility is a command line interface 
that uses the PATROL Adapter for Microsoft Office to run reports in 
the background and run batch-reporting jobs. You have the option of 
displaying the report in Microsoft Excel or saving the report to an 
Excel or HTML file. 

Features

PATROL Adapter for Microsoft Office provides an easy way to integrate 
PATROL data into Microsoft Office applications. 

• Ability to retrieve PATROL history and event data for any 
PATROL object 

PATROL Adapter for Microsoft Office allows Visual Basic for 
Applications (VBA) enabled applications to connect to PATROL 
Agents using COM and PATROL’s native interface. Statistics and 
event data collected from PATROL Agents are made available to 
VBA applications without the need for a PATROL Console.

• Easy-to-use, Windows-style PATROL Report Wizard 

The PATROL Report Wizard interface is consistent in look and feel 
with Microsoft Office products to help you use the tool more quickly. 
The source code for this application is open, providing you with a 
learning tool for using and customizing the PATROL Adapter for 
Microsoft Office.

• Predefined report types

Four predefined report types are provided with PATROL Report 
Wizard:

— Alarm and Warning Summary Report—total number of alarms 
and warnings for the selected objects during the specified time 
range
BMC Software, Inc., Confidential and Proprietary Information
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— Alarm and Warning Trend Report—total number of alarms and 
warnings for the selected objects during the specified time range 
per specified interval

— History Report—each history data point for the selected objects 
during the specified time range

— Outage Report—percent of time that the application class, 
instance, or parameter was in OK, Warn, or Alarm state during 
the specified time range. 

• Ability to create custom report types

PATROL Adapter for Microsoft Office provides its own set of Visual 
Basic objects and methods to allow you to create your own report 
types.

• Reports that you can manipulate in Microsoft Excel or other 
Microsoft Office applications

The PATROL Report Wizard allows you to generate a table and chart 
for each report in Microsoft Excel. Once it is generated, you can use 
and modify the report just as you would any report that is created in 
Microsoft Excel. You can print it in color, change the styles and 
colors of the graphs, or copy the report into another Microsoft Office 
application for further manipulation.

• Ability to save reports for later use

If you have a report that you run frequently, the PATROL Report 
Wizard allows you to save that report so that you do not have to 
recreate the report every time you want to generate it.

• Ability to publish reports to the Web

The PATROL Report Wizard includes the option to create an HTML 
version of any report that you generate. You can easily publish the 
HTML version of the report to the Web.
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• Ability to run reports in batch mode

PATROL Adapter for Microsoft Office’s Report Generator Utility 
command line interface allows you to run reports in the background.

Requirements
You must fulfill the following requirements to use PATROL Adapter for 
Microsoft Office:

• Microsoft Excel must be installed on the same machine on which 
PATROL Adapter for Microsoft Office is installed.

• To gather report information from a PATROL Agent, PATROL 
Adapter for Microsoft Office requires one of the following 
conditions:

— KMs must be preloaded on the PATROL Agent
— a PATROL Console must be connected to the PATROL Agent

• To run PATROL Adapter for Microsoft Office reports for KMs via 
the PATROL Console, you must install the PATROL Adapter for 
Microsoft Office templates for each KM on which you want to 
report. See your KMs Getting Started or online help for more 
information.

• To run PATROL Adapter for Microsoft Office reports for the OS 
KM, you must install the Patrol for Microsoft Windows Servers 
Templates.

• History and event retention must be activated in the PATROL Agent 
for history and event data to be collected by PATROL Adapter for 
Microsoft Office. For information on how to activate history and 
event retention, see “Configuring PATROL to Generate Reports” on 
page 2-2.
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• To connect the PATROL Adapter for Microsoft Office to a PATROL 
Agent, the Access Control List for that Agent must be configured to 
allow Event Manager connections from the host on which PATROL 
Adapter for Microsoft Office is installed. For information on 
configuring the PATROL Agent Access Control List, see the 
PATROL Agent Reference Manual.

• Any PATROL Agent that connects with PATROL Adapter for 
Microsoft Office must be running before report information can be 
generated for that agent.

Supported Platforms
Table 1-1 shows the hardware platforms, operating systems, and 
PATROL releases supported by PATROL Adapter for Microsoft Office.

Table 1-1 Supported Platforms for PATROL Adapter for Microsoft Office

Hardware 
Platforms Operating Systems

Microsoft Office 
Versions PATROL Versions

Intel Windows NT 4.0 (Service 
Pack 6)
Windows 2000

Microsoft Office 97 (with 
SR2)
Microsoft Office 2000 
(SR1, Service Pack 2)

PATROL 3.3.00
PATROL 3.3.01
PATROL 3.4.00
PATROL 3.4.11
PATROL 3.5.00
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Known Limitations

PATROL Adapter for Microsoft Office has the following known 
limitations:

• History data collection is not supported for PATROL Agents prior to 
PATROL 3.3.00.

• Text parameter data collection is not supported.

• Microsoft Excel charts display a limited number of items in the 
legend for a graph. PATROL Adapter for Microsoft Office allows 
you to create a report that includes more items than the maximum 
number of items that can be displayed on a Microsoft Excel chart. 
For the most useful and legible reports, it is recommended that you 
do not create reports with more items than Microsoft Excel can 
display. Please check the Microsoft Excel documentation for the 
maximum number of items that can be displayed on a Microsoft 
Excel chart.

• Any predefined report templates that are created on a machine 
running Microsoft Windows 2000 cannot be used on machines 
running Microsoft Windows NT 4.0. Microsoft Windows 2000 stores 
all registry entries in Unicode. This format is incompatible with 
previous versions of Microsoft Windows NT.
BMC Software, Inc., Confidential and Proprietary Information
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2

Getting Started with PATROL Adapter 
for Microsoft Office and PATROL 
Report Wizard 2

This chapter provides the information that you need to configure 
PATROL Adapter for Microsoft Office and set up PATROL to generate 
reports, launch the PATROL Report Wizard, and access Help. For 
information about the PATROL installation process, see the PATROL 
Installation Reference Manual. The following topics are discussed in this 
chapter:

Configuring PATROL to Generate Reports . . . . . . . . . . . . . . . . . . . . 2-3
Starting the PATROL Report Wizard from Microsoft Excel . . . . . . . 2-7
Launching PATROL Reports from a PATROL Console  . . . . . . . . . . 2-9
Starting the PATROL Report Generator Utility   . . . . . . . . . . . . . . . . 2-9
Accessing Online Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
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Configuring PATROL to Generate Reports
Before you begin generating reports using the PATROL Adapter for 
Microsoft Office wizard, you must configure the following options in 
PATROL.

• To collect history and event data, activate and set history and event 
retention to the appropriate values for the PATROL Agent on which 
you are reporting. 

• If you do not have a PATROL Console, BMC Software recommends 
that knowledge modules be preloaded on the Agent machine. If 
knowledge modules are not loaded on the Agent machine, the objects 
for that host are not available for PATROL Adapter for Microsoft 
Office to gather report information. 

For more information activating and setting history and event retention, 
see the PATROL Agent Reference Manual.

Starting the PATROL Report Wizard from 
Microsoft Excel

You can use PATROL Adapter for Microsoft Office to retrieve 
information from a PATROL Agent, even if you do not have a PATROL 
Console loaded on your local machine. If you do not have a PATROL 
Console, you must start PATROL Adapter for Microsoft Office from 
Microsoft Excel. To start PATROL Adapter for Microsoft Office from 
Microsoft Excel, follow these steps:

Step 1 Start Microsoft Excel.

Step 2 Choose File => New. 

The New dialog box is displayed.
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Step 3 Choose the Spreadsheet Solutions tab.

Step 4 Choose the Patrol Report template.

Step 5 Click OK. 

The New dialog box closes and the Microsoft Excel macros message is 
displayed.

Step 6 Click Enable Macros. 

The Microsoft Excel macros message closes and the PATROL Report 
Wizard starts.

Step 7 Complete the steps in the PATROL Report Wizard to generate a report.

Once you have started the PATROL Report Wizard in Microsoft Excel 
and generated a report, you can restart the wizard by clicking the  
icon in the Microsoft Excel toolbar. 

You can also start the wizard from the Excel menu by following these steps.

Step 1 From Microsoft Excel, select Tools => Macro => Macros. 

The Macro dialog box is displayed.

Step 2 From the list of available macros, select InitWizard.

Step 3 Click Run.

The PATROL Report Wizard is displayed.
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Launching PATROL Reports from a PATROL 
Console

Some PATROL products include predefined reports for PATROL Adapter 
for Microsoft Office that you can launch from a PATROL Console. For 
detailed instructions on generating a PATROL Adapter for Microsoft 
Office report for a PATROL product from the PATROL Console, see the 
documentation for that PATROL product.

Starting the PATROL Report Generator Utility 
PATROL Adapter for Microsoft Office provides a report generator utility 
that you can start from a command line. This utility allows you to 
generate batch reports and save reports directly to a file without 
accessing the Microsoft Excel interface. For information about using the 
PATROL Report Generator utility, see Chapter 4, “Generating Reports 
With the PATROL Report Generator Utility.”
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Accessing Online Help

Help is available for the PATROL Adapter for Microsoft Office wizard in 
the form of tool tips Help and what’s this Help. 

What’s this Help provides more detailed descriptions of the wizard fields 
and buttons. To access what’s this Help for the PATROL Adapter for 
Microsoft Office wizard, click the  icon in the title bar of the wizard, 
shown in Figure 2-1. The cursor changes to a . Using this cursor, 
click a wizard field or button to get a popup box that contains detailed 
information on that part of the interface. 

Figure 2-1   What’s This Help
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3

Generating Reports With the PATROL 
Report Wizard 3

This chapter explains how to generate, save, and update reports using the 
PATROL Report Wizard.

Connecting to Hosts Using the PATROL Report Wizard  . . . . . . . . . 3-2
Generating Reports from Templates  . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
Generating Custom Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

Changing Templates into Customized Reports . . . . . . . . . . . . . . 3-6
Creating New Custom Reports . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

Creating and Adding Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
Saving Reports as Microsoft Excel Files . . . . . . . . . . . . . . . . . . . . . . 3-21
Saving a Report in HTML Format  . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
Exporting Report Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-25
Importing Report Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-26
Updating Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-27
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Connecting to Hosts Using the PATROL Report 
Wizard

Before you can use the PATROL Report Wizard, you must connect to the 
hosts for which you want to generate reports. The PATROL Report 
Wizard connects to hosts through the PATROL Adapter for Microsoft 
Office COM server which gathers information from the PATROL Agents 
on the hosts.

To connect to a host using the PATROL Report Wizard

Step 1 Start the PATROL Report Wizard from Microsoft Excel. For information 
about starting the wizard, see “Starting the PATROL Report Wizard from 
Microsoft Excel” on page 2-2.

Step 2 On the first screen of the wizard, click Add as shown in Figure 3-1.

Figure 3-1   Add Host Connection Button

The Add Host dialog box appears as shown in Figure 3-2.
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Figure 3-2   Add Host Dialog Box

Step 3 Fill in the Add Host dialog box fields as appropriate.

Step 4 Click Add.

The Add Host dialog box closes and the host is added to the host list on 
the first screen of the PATROL Report Wizard. Repeat the process to add 
more hosts to the list.

Continue through the steps of the wizard to generate reports.

Generating Reports from Templates
Some PATROL components provide predefined report templates that 
allow you to instantly create commonly-used reports for those products. 
The predefined reports templates define 

• report type 
• time interval for the report
• grouping options for the report information
• application classes, instances and parameters to be included in the 

report

You can use one of these predefined report types or you can create a 
custom report type. For information about creating custom report types, 
see “Generating Custom Reports” on page 3-6.
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To Generate a Report from a Template

Step 1 Start the PATROL Report Wizard from Microsoft Excel. For information 
about starting the wizard, see “Starting the PATROL Report Wizard from 
Microsoft Excel” on page 2-2.

Step 2 If necessary, connect to the hosts that you want to monitor. For 
information on connecting to hosts, see “Connecting to Hosts Using the 
PATROL Report Wizard” on page 3-2.

Step 3 Select the check box next to the hosts that you want to include in the 
report as shown in Figure 3-3.

Figure 3-3   Select Host Screen

Note
At this point you have the option of selecting the Save Connection 
Information check box, shown in Figure 3-4. If you select this check box, 
host and password information is saved to the current Microsoft Excel 
worksheet. For greater security it is recommended that you password 
protect any Microsoft Excel worksheets that you create and save while 
this check box is enabled.
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Figure 3-4   Save Connection Information Checkbox

Step 4 Click Next.

Step 5 From the report templates list, select the name of the predefined report 
that you want to generate as shown in Figure 3-5. 

Note
If the PATROL for Microsoft Windows Servers Templates are installed, 
they will appear in this step of the wizard.

Figure 3-5   Select Predefined Report Screen

Step 6 Click Finish. 

The wizard closes and the report is generated in Microsoft Excel.

Note
Once you have started the PATROL Report Wizard in Microsoft Excel 
and generated a report, you can restart the wizard by clicking the  
icon in the Microsoft Excel toolbar.
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Generating Custom Reports
You have two ways to create custom reports using the PATROL Report 
Wizard. You can create a custom report 

• by changing an existing report template 
• by selecting the application classes, instances, and parameters that 

you want to include in the report, selecting a report format, selecting 
a time interval, then defining how you want the information to be 
grouped

Changing Templates into Customized Reports

To generate a custom report that is based on a predefined report, you can 
modify a report template. To do so, follow these steps:

Step 1 Start the PATROL Report Wizard from Microsoft Excel. For instructions 
on starting the wizard, see “Starting the PATROL Report Wizard from 
Microsoft Excel” on page 2-2.

Step 2 If necessary, connect to the hosts that you want to monitor. For 
information on connecting to hosts, see “Connecting to Hosts Using the 
PATROL Report Wizard” on page 3-2.

Note
At this point you have the option of selecting the Save Connection 
Information check box, shown in Figure 3-6. If you select this check box, 
host and password information is saved to the current Microsoft Excel 
worksheet. For greater security it is recommended that you password 
protect any Microsoft Excel worksheets that you create and save while 
this check box is enabled.
BMC Software, Inc., Confidential and Proprietary Information

3-6 PATROL Adapter for Microsoft Office User Guide



Figure 3-6   Save Connection Information Checkbox

Step 3 Select the check box next to the hosts that you want to include in the 
report as shown in Figure 3-7.

Figure 3-7   Select Host Screen

Step 4 Click Next.

Step 5 From the report templates list, select the name of the predefined report 
that you want to base your report on as shown in Figure 3-8.
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Figure 3-8   Select Report Template Screen

Step 6 Click Next. 

Step 7 Click through Step 3 through Step 6 to make any changes to the objects 
included in the report or the report scheduling, averaging, or grouping 
options.

Note
The modifications that you make to the report template are temporary 
unless you save the modified predefined report under another name. For 
information about saving reports, see “Creating and Adding Templates” 
on page 3-16.

Step 8 When you are finished modifying the predefined report settings, click 
Finish.

The wizard closes and the report is generated in Microsoft Excel.

Note
Once you have started the PATROL Report Wizard in Microsoft Excel 
and generated a report, you can restart the wizard by clicking the  
icon in the Microsoft Excel toolbar.
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Creating New Custom Reports

If none of the predefined reports suits your needs, you can create a 
customized report using the PATROL Report Wizard. The customized 
report allows you to 

• select which hosts you want to include in the report
• select from four commonly used predefined report types
• define a time interval for the data that you want to include in the 

report
• select how you want your report to be grouped

For information about creating and adding a custom report that you can 
add to the predefined reports list, see “Creating and Adding Templates” 
on page 3-16.

To create a custom report, follow these steps:

Step 1 Start the PATROL Report Wizard from Microsoft Excel. For instructions 
on starting the wizard, see “Starting the PATROL Report Wizard from 
Microsoft Excel” on page 2-2.

Step 2 If necessary, connect to the hosts that you want to monitor. For 
instructions on connecting to hosts, see “Connecting to Hosts Using the 
PATROL Report Wizard” on page 3-2.

Note
At this point you have the option of selecting the Save Connection 
Information check box, shown in Figure 3-9. If you select this check box, 
host and password information is saved to the current Microsoft Excel 
worksheet. For greater security it is recommended that you password 
protect any Microsoft Excel worksheets that you create and save while 
this check box is enabled.
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Figure 3-9   Save Connection Information Checkbox

Step 3 Select the check box next to the hosts that you want to include in the 
report as shown in Figure 3-10.

Figure 3-10   Select Host Screen

Step 4 Click Next.

Step 5 From the report templates list, select CUSTOM REPORT as shown in 
Figure 3-11.
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Figure 3-11   Select CUSTOM REPORT Screen

Step 6 Click Next.

Note
If you are creating a History Report, the Application Class and Instance 
grouping options are not available under the Add To Chart section. All 
Grouping Options radio buttons are available and the Save report in 
HTML format option is available.
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Step 7 Select one of the predefined report types described in Table 3-1.

Step 8 Click Next.

Step 9 Select the application classes, instances, and/or parameters that you want 
to include in the report as shown in Figure 3-12.

Table 3-1 PATROL Adapter for Microsoft Office Report Types

Report Type Description

Alarm and Warning Summary 
Report

Displays the total number of alarms and warnings for the selected 
objects during the specified time range.

Alarm and Warning Trend 
Report

Displays the total number of alarms and warnings for the selected 
objects during the specified time range per specified interval.
This report cannot be run for a period greater than 10 days when 
averaged by hour. If you must run this report for a period greater 
than 10 days, average the report by days, weeks, or months.

History Report Displays each history data point for the selected objects during the 
specified time range per specified interval.

Outage Report Displays the percentage of time that the application class, instance, 
or parameter was in OK, Warning, or Alarm state during the 
specified time range.
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Figure 3-12   Select Host Objects Screen

Note
If you have more than one host selected to be included in the report, any 
instances that you select for one host that are present in the other hosts 
are included in the report, regardless of whether or not you select those 
instances in the host objects screen.

Step 10 Click Next.

Step 11 Select a schedule option. You can either define a specific range of time 
by selecting the Start to End radio button, or you can collect data for a 
specified amount of time in the past until the current time by selecting the 
From Previous Number of Days, Hours radio button.

Step 12 Select an average interval if you want the data to be averaged by minute, 
hour, day, week, or month, select the appropriate average interval. If you 
want to see every data point, select None for the Average Interval.

Note
Selecting None for the Average Interval is not recommended unless you 
have very few data points. Too many data points can overload the chart, 
making it difficult to read.
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Figure 3-13 shows the schedule and averaging options for a report that 
displays information for the past week, averaged daily.

Figure 3-13   Report Schedule and Average Options Screen

Step 13 Click Next.

Step 14 From the Object Types field, select the object types that you want to 
include in the report. 

Step 15 If you want to group the data by creating a separate report for each 
application class, instance, or parameter, select the appropriate radio 
button. If you want to include all the data in one report, select None.

Figure 3-14 shows the grouping options for a report that displays 
application classes, instances, and parameters. The information for each 
application class will be displayed on a separate Excel chart.
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Figure 3-14   Report Grouping Options Screen

Step 16 Click Finish. 

The wizard closes and the report is generated in Microsoft Excel.
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Creating and Adding Templates

PATROL Adapter for Microsoft Office allows you to create custom 
reports that you can add to the predefined reports list. If you have a 
custom report that you run often, creating a predefined report saves you 
the time and effort of creating the custom report over and over again.

Note
Creating a predefined report in this manner saves the report to your 
Windows NT registry. To save a report template to a file, you must export 
the template. For more information, see “Exporting Report Templates” 
on page 3-24.

Any templates that are created on a machine running Microsoft Windows 
2000 cannot be used on machines running Microsoft Windows NT 4.0. 
Microsoft Windows 2000 stores all registry entries in Unicode. This 
format is incompatible with previous versions of Microsoft Windows NT.

To create and add a custom report to the predefined reports list, follow 
these steps:

Step 1 Start the PATROL Report Wizard from Microsoft Excel. 

Step 2 If necessary, connect to the hosts that you want to monitor. 

Note
At this point you have the option of selecting the Save Connection 
Information check box, shown in Figure 3-15. If you select this check 
box, host and password information are saved to the current Microsoft 
Excel worksheet. For greater security it is recommended that you 
password protect any Microsoft Excel worksheets that you create and 
save while this check box is enabled.
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Figure 3-15   Save Connection Information Checkbox

Step 3 Select the checkbox next to the hosts that you want to include in the 
report.

Step 4 Click Next.

Step 5 Click Add. 

The report template wizard is displayed as shown in Figure 3-16.

Figure 3-16   Report Template Wizard Properties Screen

Step 6 Enter a unique name for the template, the name and the version number 
of the knowledge module from which the report is collecting data. 

Note
The template fields are designed to help you identify and version the 
predefined reports that you create. You are not required to fill in these 
fields with specific values.
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Step 7 Click Next.

Step 8 Select one of the predefined report types described in Table 3-1.

Step 9 Click Next.

Step 10 Select the application classes, instances, and/or parameters that you want 
to include in the report as shown in Figure 3-17.

Figure 3-17   Report Template Host Objects Screen

Table 3-2 PATROL Adapter for Microsoft Office Report Types

Report Type Description

Alarm and Warning Summary 
Report

displays the total number of alarms and warnings for the selected 
objects during the specified time range

Alarm and Warning Trend 
Report

displays the total number of alarms and warnings for the selected 
objects during the specified time range per specified interval

History Report displays each history data point for the selected objects during the 
specified time range per specified interval

Outage Report displays the percentage of time that the application class, instance, 
or parameter was in OK, Warning, or Alarm state during the 
specified time range
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Step 11 Select a schedule option. Either define a specific range of time by 
selecting the Start to End radio button, or collect data for a specified 
amount of time in the past until the current time by selecting the From 
Previous Number of Days, Hours radio button. If you want the data to be 
averaged by minute, hour, day, week, or month, select the appropriate 
average interval. If you want to see every data point, select None for the 
Average Interval.

Note
Selecting None for the Average Interval is not recommended unless you 
have very few data points. Too many data points can overload the chart, 
making it difficult to read.

Figure 3-18 shows the Start to End and the average information By Day 
options are enabled.

Figure 3-18   Report Template Schedule and Average Options Screen
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Step 12 Click Next.

Step 13 From the Object Types field, select the object types that you want to 
include in the report as shown in Figure 3-19.

Figure 3-19   Report Template Grouping Options Screen

Step 14 If you want to group the data by creating a separate report for each 
application class, instance, or parameter, select the appropriate radio 
button. If you want to include all the data in one report, select None.

Note
If you are creating a History Report, the Application Class and Instance 
grouping options are not available.

Step 15 Click Finish. 

The report template wizard closes and the report is added to the 
predefined reports list in the PATROL Report Wizard.

Step 16 To generate your new report, select it from the list and click Finish. 

The PATROL Report Wizard closes and the report is generated in 
Microsoft Excel.
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Saving Reports as Microsoft Excel Files
PATROL Report Wizard allows you to create a report, then save it for 
future use. 

Warning
All report template information is stored in the Windows NT registry. If 
you create a report, then want to run the wizard to create another report, 
all report template data is lost unless you save the report. 

Once you have saved a report, you can open the report in Microsoft Excel 
and use the PATROL Report Wizard to refresh the information in the 
report. For information about refreshing reports, see “Updating Reports” 
on page 3-26.

Note
This procedure does not create a template that can be added to the 
predefined reports list and modified to create other reports. To save a 
report as a template, you must export the report to a file. For more 
information, see “Exporting Report Templates” on page 3-24.

To save a report, follow these steps:

Step 1 Generate a report. 

Step 2 In Microsoft Excel select File => Save. 

The Save As dialog box is displayed. 

Step 3 Browse to the location where you want to store the report.

Step 4 In the File name field, enter a name for the report.

Step 5 Click Save. 

The Save As dialog box closes and the report is saved in the location that 
you specified.
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Saving a Report in HTML Format

You can save reports in HTML format so that you can display them on 
the Web. The option to save the report as HTML format is on the last 
screen of the PATROL Report Wizard, so the procedure to save a report 
in HTML format depends on whether you are generating a predefined 
report or a custom report.

To Save a Report in HTML Format

Step 1 Start the PATROL Report Wizard from Microsoft Excel. For instructions 
on starting the wizard, see “Starting the PATROL Report Wizard from 
Microsoft Excel” on page 2-2.

Step 2 If necessary, connect to the hosts that you want to monitor. 

Note
At this point you have the option of selecting the Save Connection 
Information check box, shown in Figure 3-20. If you select this check 
box, host and password information are saved to the current Microsoft 
Excel worksheet. For greater security it is recommended that you 
password-protect any Microsoft Excel worksheets that you create and 
save while this check box is enabled.

Figure 3-20   Save Connection Information Checkbox

Step 3 Select the check box next to the hosts that you want to include in the 
report.

Step 4 Click Next.

Step 5 From the report templates list, select the name of the predefined report 
that you want to generate.
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Step 6 On the PATROL Report Wizard map on the left side of the screen, click 
the Create/Save step as shown in Figure 3-21.

Figure 3-21   Create/Save Step Shortcut

The wizard skips to the last screen of the wizard.

Step 7 Select the Save report in HTML format check box as shown in Figure 
3-22.

Figure 3-22   Save report in HTML format Check box

Step 8 Enter or browse for the file location and file name where you want to 
save the HTML file.

Step 9 Click Finish. 

The report is generated in Microsoft Excel and is saved as the file name 
you entered in the location you specified.
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To Save a Custom Report in HTML Format

Step 1 Generate a report by following all the steps in the PATROL Report 
Wizard. For information about generating custom reports, see 
“Generating Custom Reports” on page 3-6.

Step 2 On the last screen of the wizard, select the Save report in HTML format 
check box.

Step 3 Enter or browse for a file location and file name where you want to save 
the HTML file.

Step 4 Click Finish. 

The report is generated in Microsoft Excel and is saved as the file name 
you entered in the location you specified.

Exporting Report Templates

If you want to save a predefined template to a file so that it can be used 
on another machine to create reports, you must export the report to a file. 
To export a report to a file, follow these steps:

Step 1 If the report that you want to export to a file is not included on the 
predefined reports list, create and add a predefined report as described in 
“Creating and Adding Templates” on page 3-16.

Step 2 Select the predefined report from the predefined reports list located on 
the Report Templates screen of the PATROL Report Wizard.

Note
Any templates that are created on a machine running Microsoft Windows 
2000 cannot be used on machines running Microsoft Windows NT 4.0. 
Microsoft Windows 2000 stores all registry entries in Unicode. This 
format is incompatible with previous versions of Microsoft Windows NT.
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Step 3 Click Export. 

The Export PATROL Adapter for Microsoft Office Predefined Report 
Description into a File dialog box is displayed.

Step 4 Browse to the location where you want to save the report template.

Step 5 Enter a file name for the report template and click Save. 

The report template is saved to the location that you specified.

Importing Report Templates

If you have created a predefined report template by some means other 
than using the PATROL Report Wizard, or you would like to add a 
predefined report template that you have exported to a file (see 
“Exporting Report Templates” on page 3-24) to the predefined reports 
list, you can add that template to the predefined reports list by following 
these steps:

Step 1 Start the PATROL Report Wizard.

Step 2 Select any host in the host list. 

Note
Selecting a host does not affect importing reports; it just enables the Next 
button so that you can access the predefined report template screen.

Step 3 Click Next.

Step 4 Click Import. 

The Import PATROL Adapter for Microsoft Office Predefined Report 
Description File dialog box is displayed.
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Step 5 Browse to the location of the template that you want to import.

Step 6 Select the template and click Open. 

The template is added to the predefined templates list.

Updating Reports

Once you have generated a report in Microsoft Excel, you can update the 
information in the report by clicking the Update icon (shown at left) in 
the Microsoft Excel toolbar or by rerunning the report in the PATROL 
Report Wizard. You can also update the report by following these steps:

Step 1 From Microsoft Excel, select Tools => Macro => Macros. 

The Macro dialog box is displayed.

Step 2 From the list of available macros, select updateCurrentReport.

Step 3 Click Run.

The report is updated with the most recent information.
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4

Generating Reports With the PATROL 
Report Generator Utility 4

The following chapter explains how to use the PATROL Report 
Generator utility to generate reports in the background.

PATROL Report Generator Features . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Generating Reports Using the Report Generator Interface . . . .  4-2
Generating Reports From a Command Line or Batch File . . . . . 4-6

Generating Reports in Batch Mode . . . . . . . . . . . . . . . . . . . . . . . . . . 4-10
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PATROL Report Generator Features

The PATROL Report Generator utility is a command line utility that 
generates a report in the background and displays it in Microsoft Excel. 
With the report generator, you can define these report parameters:

• host name
• port number
• user name
• password
• application classes, instances, and parameter names
• report type
• time range
• interval option
• averaging option

The report generator utility can be started in silent (-s argument) or GUI 
mode. Silent mode is useful when you

• do not want Microsoft Excel to run
• want to generate reports in batch mode

Generating Reports Using the Report Generator Interface

To create reports in GUI mode without using the PATROL Report 
Wizard, you can launch the PATROL Report Generator utility from the 
command line. This utility displays a dialog box that you can use to 
select report options. 

To launch the PATROL Report Generator utility in GUI mode

» Enter the following command at the DOS prompt from the 
%PATROL_HOME%\<pamo directory:>

prgen -host hostname -port number -user name -password password -objects object1,object2...
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Table 4-1 describes the arguments for the prgen command.

When you execute the prgen command, the PATROL Report Generator 
dialog box is displayed as shown in Figure 4-1.

Table 4-1 PATROL Report Generator Utility GUI Command Arguments

Argument Description

-host <hostname> the host from which report information is collected

-port <number> the port number for the host

-user <name> the user name for the host account

-password <password> the password for the user’s account

-objects <object1,object2> the application classes, instance names, or parameters from which 
you want to collect information for the specified host. You can use 
wildcards to represent instances. 
Example: NT_CPU/*/parameter_name generates a report that 
includes the information for parameter_name for all CPU application 
class instances.
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Figure 4-1   PATROL Report Generator Utility Display Options

To Generate a Report From the PATROL Report Generator Dialog Box

Step 1 From the drop list, select one of the predefined report types described in 
Table 4-2.

Table 4-2 PATROL Report Generator Utility Report Types

Report Type Description

Alarm and Warning Summary 
Report

the total number of alarms and warnings for the selected objects 
during the specified time range

Alarm and Warning Trend 
Report

each alarm and warning for the selected objects during the 
specified time range

History Report each history data point for the selected objects during the specified 
time range

Outage Report the percentage of time that the application class, instance, or 
parameter was available during the specified time range. The 
percentage is calculated by gathering all the history points for a 
specified range and determining the amount of time that the points 
were not occupying the Alarm or Warning ranges.
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Step 2 From the Add to Chart area, select the objects types that you want to 
include in the report. 

Step 3 From the Grouping Options area, select the radio button that offers the 
grouping that you want for your data. These options let you create a 
separate report for each application class, instance, or parameter. To 
include all the data in one report, select None.

Note
If you are creating a History Report, the Application Class and Instance 
grouping options are not available.

Step 4 To save the report as an HTML file, select the Save report in HTML 
format check box.

Step 5 Enter or browse for a file location and file name where you want to save 
the HTML file.

Step 6 Select the Schedule Options tab. 

The PATROL Report Generator dialog box is displayed as shown in 
Figure 4-2.
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Figure 4-2   PATROL Report Generator Utility Schedule Options

Step 7 Select one of these schedule options:

• Start to End—define a specific range of time
• From Previous Number of Days, Hours—collect data for a specified 

amount of time in the past until the current time

Step 8 Select the appropriate averaging interval. To see every data point, select 
None for the Average Interval. 

Averaging is not valid for the Alarm and Warning Summary Report or 
the Outage Report.

Note
Selecting None for the Average Interval is not recommended unless you 
have very few data points. Too many data points can overload the chart.

Step 9 Click OK. 
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Generating Reports From a Command Line or Batch File

Using the command line utility in silent mode, you can generate a report 
and then

• save the report in a Microsoft Excel and/or HTML file
• display the report in Microsoft Excel 

To start the PATROL Report Generator utility in silent mode, you must 
define all arguments for the prgen command and enter the -s argument at 
the end of the prgen command. You can define the arguments from the 
command line, or you can write a batch file that includes all the 
arguments. 

To Launch the PATROL Report Generator in Silent Mode

» From the command line enter:

%PATROL_HOME\pamo\prgen -host hostname -port number -user name -password password | 

-encrpassword password -objects object1,object2, ... | -template filename -type “Event Summary 

Report” | “Event Trend Report” | “History Report” | “Outage Report” -start #date# -end #date# -aver-

age 0|1|2|3|4|5 -rtype 0|1 -interval minutes -group 0|1|2|3|4|5 -add 001|011|111|100|110|010 -html 

filename -xlFile filename [-xlPassword password] -s 

Table 4-3 defines all the arguments for the prgen command.

Table 4-3 PATROL Report Generator Utility Silent Command Arguments  (Part 1 of 4)

Argument Description
Required/
Optional

-host <hostname> specifies the host from which report information is 
collected

required

-port <number> specifies the port number for the host required

-user <name> specifies the user name for the host account required

-password 
<password>

specifies the password for the user’s account required if 
-encrpassword 
argument is not used
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-encrpassword 
<password>

specifies the PEM API encrypted password to be 
used for this account

required if -password 
argument is not used

-objects <object1, 
object2>

specifies the application classes, instance names, 
or parameters from which you want to collect 
information for the specified host

required if -template 
argument is not used

-template <KM 
name\version\repor
t name>

specifies the KM, version, and name of a 
predefined template that has been created using 
the PATROL Adapter for Microsoft Office wizard. 
The information should match that of the columns 
found in GUI version of the PATROL Adapter for 
Microsoft Office Wizard. For more information, see 
page 3-17.
No report is created if no data exists.
Examples: “PATROL for Windows NT 
Server\1.2.00\CPU Utilization - Daily History 
Report”

required if -objects 
argument is not used

-type “report_type” specifies the report type to be generated:
“Event Summary Report” displays the total 
number of alarms and warnings for the specified 
objects during the specified time range.
“Event Summary Report Trend Report” displays 
each alarm and warning for the specified objects 
during the specified time range.
“History Report” displays each history data point 
for the specified objects during the specified time 
range.
“Outage Report” displays the percent of time that 
the application class, instance, or parameter was 
available during the specified time range. 

required if -template 
argument is not used

-start #<date># specifies the date to begin collecting data for the 
report in Visual Basic format
Examples: #January 1, 2001#
#1 Jan 01#
#1/1/2001# 
#17:04:23# 

• required if the value of 
-rtype argument is 0

• not valid if -template 
is used

Table 4-3 PATROL Report Generator Utility Silent Command Arguments  (Part 2 of 4)

Argument Description
Required/
Optional
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-end #<date># specifies the date to stop collecting data for the 
report in Visual Basic format
Examples: #January 1, 2001#
#1 Jan 01#
#1/1/2001# 
#17:04:23# 

• required if the value of 
-rtype argument is 0

• not valid if -template 
is used

-average <option>† specifies if and how the report data will be 
averaged:
0—displays all the data
1—displays the average data per minute
2—displays the average data per hour
3—displays the average data per day
4—displays the average data per week
5—displays the average data per year

• required
• not valid if -template 

is used

-rtype <option> specifies the type of time range that the report 
covers:
0—report covers specific dates
1—report covers specified time in the past to the 
present time

• required
• not valid if -template 

is used

-interval <minutes> specifies the amount of time in the past that data is 
to be collected if the -rtype argument value is 1

• required if -rtype 
value is 1

• not valid if -template 
is used

-group <option>* determines how data is grouped in the report:
0—all applications are included in one chart
1—one chart is created for each application
2—one chart is created for each application and 
instance
3—one chart is created for each instance
4—one chart is created for each parameter and 
application
5—one chart is created for each parameter

• required
• not valid if -template 

is used

Table 4-3 PATROL Report Generator Utility Silent Command Arguments  (Part 3 of 4)

Argument Description
Required/
Optional
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*See Table 4-4 for a list of dependencies between -add and -group.

**These options are invalid for History Reports.

†This argument is not valid for Alarm and Warning Summary Reports or Outage Reports.

-add <option>* determines what objects are displayed in the report:
100—adds application classes to the report**
010—adds instances to the report**
001—adds parameters to the report
110—adds application classes and instances to the 
report**
111—adds application classes, instances, and 
parameters to the report**
011—adds instances and parameters to the 
report**

• required
• not valid if -template 

is used

-html <filename> specifies to save the report to an HTML file with the 
specified name

optional

-xlFile <filename> specifies to save the report to a Microsoft Excel file 
with the specified name

optional

-xlPassword 
<password>

specifies the password for the Microsoft Excel file to 
which the report is saved if that file is password 
protected

required only if -xlFile is 
used and the Excel file 
is password-protected

-s generates reports without the GUI dialog box when 
used with -xlFile and/or -html and/or -v arguments

optional; must be used 
with -xlFile and/or -html 
and/or -v arguments

-u specifies to automatically update the file specified 
by the -xlFile argument

optional; must be used 
with -xlFile and/or -html 
arguments

-v displays the report in a Microsoft Excel worksheet if 
-html or -xlFile arguments are used

optional; must be used 
with -s argument

Table 4-3 PATROL Report Generator Utility Silent Command Arguments  (Part 4 of 4)

Argument Description
Required/
Optional
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The -add and -group options have dependencies that may invalidate some 
of the -group options. lists these dependencies.

Table 4-4 -add and -group Dependencies

If you use this -add option... These -group options are valid...

100—adds application classes to the 
report

0—all applications are included in one chart
1—one chart is created for each application

010—adds instances to the report 0—all applications are included in one chart
1—one chart is created for each application
2—one chart is created for each application and instance
3—one chart is created for each instance

001—adds parameters to the report 0—all applications are included in one chart
1—one chart is created for each application
2—one chart is created for each application and instance
3—one chart is created for each instance
4—one chart is created for each parameter and application
5—one chart is created for each parameter

110—adds application classes and 
instances to the report

0—all applications are included in one chart
1—one chart is created for each application
2—one chart is created for each application and instance
3—one chart is created for each instance

111—adds application classes, 
instances, and parameters to the 
report

0—all applications are included in one chart
1—one chart is created for each application
2—one chart is created for each application and instance
3—one chart is created for each instance
4—one chart is created for each parameter and application
5—one chart is created for each parameter

011—adds instances and parameters 
to the report

0—all applications are included in one chart
1—one chart is created for each application
2—one chart is created for each application and instance
3—one chart is created for each instance
4—one chart is created for each parameter and application
5—one chart is created for each parameter
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Generating Reports in Batch Mode
You can run batch reports by using the prgen command in a batch file.

Figure 4-3 shows a batch file that creates a report that saves the history 
data of the following parameters for each NT_CPU application class 
instance:

• CPUprcpProcTimePercent
• CPUprcrProcessorTimePercent
• CPUprcrPrivTimePercent

The report is saved in an HTML file (-html argument is used) and does 
not display in Microsoft Excel (-v argument is not used).

Figure 4-3   Sample Batch Program for Saving a Report To an HTML File

Table 4-5 explains each of the arguments used in the sample program 
shown in Figure 4-3.

Table 4-5 Sample Batch Program Argument Descriptions  (Part 1 of 2)

Argument Description

%PATROL_HOME\pamo\prgen starts the report generator utility from its home directory

-host myhost the host

-port 1987 the port number for the host

-user myname the user name for the host

-password mypassword the password for the host

-type "History Report" the report type as History Report. History Report displays 
all the history data for the objects specified by -objects.

%PATROL_HOME\pamo\prgen -host myhost -port 1987 -user myname -password 
mypassword -type "History Report" -objects NT_CPU/*/CPUprcpProcTimePercent, 
NT_CPU/*/CPUprcrProcessorTimePercent, NT_CPU/*/CPUprcrPrivTimePercent 
-start #09/01/99# -end #09/02/99# -average 2 -rtype 0 -group 1 -add 110 
-html "C:\Program Files\Office\myhtml.html" -s 
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-objects 
NT_CPU/*/CPUprcpProcTimePercent, 
NT_CPU/*/CPUprcrProcessorTimePercen
t, NT_CPU/*/CPUprcrPrivTimePercent

specifies the parameters to be included in the report. 
The wildcard * indicates that the data is to be included for 
all instances.

-start #09/01/99# the date to begin gathering data

-end #09/02/99# the date to stop gathering data

-average 2 specifies that the data will be averaged and displayed by 
the hour

-rtype 0 specifies that the range type for the report is from one 
specific date to another

-group 1 specifies that one chart is created for each application

-add 110 specifies that application classes and instances will be 
displayed in the report

-html "C:\Program 
Files\Office\myhtml.html"

specifies that the report will be saved in an HTML file in 
the named location

-s specifies that the report will be saved directly to the 
HTML file, so that you do not interact with the report 
generator dialog boxes

Table 4-5 Sample Batch Program Argument Descriptions  (Part 2 of 2)

Argument Description
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STOP!

IMPORTANT INFORMATION - DO NOT INSTALL THIS PRODUCT UNLESS YOU HAVE 
READ ALL OF THE FOLLOWING MATERIAL

By clicking the YES or ACCEPT button below (when applicable), or by installing and using this Product or by having it
installed and used on your behalf, You are taking affirmative action to signify that You are entering into a legal agreement and
are agreeing to be bound by its terms, EVEN WITHOUT YOUR SIGNATURE. BMC is willing to license this Product to You ONLY
if You are willing to accept all of these terms. CAREFULLY READ THIS AGREEMENT. If You DO NOT AGREE with its terms, DO
NOT install or use this Product; press the NO or REJECT button below (when applicable) or promptly contact BMC or your
BMC reseller and your money will be refunded if by such time You have already purchased a full-use License.

SOFTWARE LICENSE AGREEMENT FOR BMC PRODUCTS

SCOPE. This is a legally binding Software License Agreement (“License”) between You (either an individual or an entity) and BMC
pertaining to the original computer files (including all computer programs and data stored in such files) contained in the enclosed Media
(as defined below) or made accessible to You for electronic delivery, if as a prerequisite to such accessibility You are required to
indicate your acceptance of the terms of this License, and all whole or partial copies thereof, including modified copies and portions
merged into other programs (collectively, the “Software”). “Documentation” means the related hard-copy or electronically
reproducible technical documents furnished in association with the Software, “Media” means the original BMC-supplied physical
materials (if any) containing the Software and/or Documentation, “Product” means collectively the Media, Software, and
Documentation, and all Product updates subsequently provided to You, and “You” means the owner or lessee of the hardware on
which the Software is installed and/or used. “BMC” means BMC Software Distribution, Inc. unless You are located in one of the
following regions, in which case “BMC” refers to the following indicated BMC Software, Inc. subsidiary: (i) Europe, Middle East or Africa
--BMC Software Distribution, B.V., (ii) Asia/Pacific -- BMC Software Asia Pacific Pte Ltd., (iii) Brazil -- BMC Software do Brazil, or (iv)
Japan -- BMC Software K.K. If You enter into a separate, written software license agreement signed by both You and BMC or
your authorized BMC reseller granting to you the rights to install and use this Product, then the terms of that separate, signed
agreement will apply and this License is void.

FULL-USE LICENSE. Subject to these terms and payment of the applicable license fees, BMC grants You this non-exclusive License
to install and use one copy of the Software for your internal use on the number(s) and type(s) of servers or workstations for which You
have paid or agreed to pay to BMC or your BMC reseller the appropriate license fee. If your license fee entitles You only to a License
having a limited term, then the duration of this License is limited to that term; otherwise this License is perpetual, subject to the
termination provisions below. 

TRIAL LICENSE. If You have not paid or agreed to pay to BMC or your BMC Reseller the appropriate license fees for a full use license,
then, NOTWITHSTANDING ANYTHING TO THE CONTRARY CONTAINED IN THIS LICENSE: (i) this License consists of a
non-exclusive evaluation license (“Trial License”) to use the Product for a limited time (“Trial Period”) only for evaluation; (ii) during the
Trial Period, You may not use the Software for development, commercial, production, database management or other purposes than
those expressly permitted in clause (i) immediately above; and (iii) your use of the Product is on an AS IS basis, and BMC, ITS
RESELLERS AND LICENSORS GRANT NO WARRANTIES OR CONDITIONS (INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE) TO YOU AND ACCEPT NO LIABILITY WHATSOEVER
RESULTING FROM THE USE OF THIS PRODUCT UNDER THIS TRIAL LICENSE. If You use this Product for other than evaluation
purposes or wish to continue using it after the Trial Period, you must purchase a full-use license. When the Trial Period ends, your right
to use this Product automatically expires, though in certain cases You may be able to extend the term of the Trial Period by request.
Contact BMC or your BMC reseller for details.

TERM AND TERMINATION. This License takes effect on the first to occur of the date of shipment or accessibility to You for electronic
delivery, as applicable (the “Product Effective Date”). You may terminate this License at any time for any reason by written notice to
BMC or your BMC reseller. This License and your right to use the Product will terminate automatically with or without notice by BMC if
You fail to comply with any material term of this License. Upon termination, You must erase or destroy all components of the Product
including all copies of the Software, and stop using or accessing the Software. Provisions concerning Title and Copyright, Restrictions
(or Restricted Rights, if You are a U.S. Government entity) or limiting BMC’s liability or responsibility shall survive any such termination.

TITLE AND COPYRIGHT; RESTRICTIONS. All title and copyrights in and to the Product, including but not limited to all modifications
thereto, are owned by BMC and/or its affiliates and licensors, and are protected by both United States copyright law and applicable
international copyright treaties. You will not claim or assert title to or ownership of the Product. To the extent expressly permitted by
applicable law or treaty notwithstanding this limitation, You may copy the Software only for backup or archival purposes, or as an
essential step in utilizing the Software, but for no other purpose. You will not remove or alter any copyright or proprietary notice from



copies of the Product. You acknowledge that the Product contains valuable trade secrets of BMC and/or its affiliates and licensors.
Except in accordance with the terms of this License, You agree (a) not to decompile, disassemble, reverse engineer or otherwise
attempt to derive the Software’s source code from object code except to the extent expressly permitted by applicable law or treaty
despite this limitation; (b) not to sell, rent, lease, license, sublicense, display, modify, time share, outsource or otherwise transfer the
Product to, or permit the use of this Product by, any third party; and (c) to use reasonable care and protection to prevent the
unauthorized use, copying, publication or dissemination of the Product and BMC confidential information learned from your use of the
Product. You will not export or re-export any Product without both the written consent of BMC and the appropriate U.S. and/ or
foreign government license(s) or license exception(s). Any programs, utilities, modules or other software or documentation
created, developed, modified or enhanced by or for You using this Product shall likewise be subject to these restrictions. BMC has the
right to obtain injunctive relief against any actual or threatened violation of these restrictions, in addition to any other available
remedies. Additional restrictions may apply to certain files, programs or data supplied by third parties and embedded in the Product;
consult the Product installation instructions or Release Notes for details.

LIMITED WARRANTY AND CONDITION. If You have purchased a Full-Use License, BMC warrants that (i) the Media will be, under
normal use, free from physical defects, and (ii) for a period of ninety (90) days from the Product Effective Date, the Product will perform
in substantial accordance with the operating specifications contained in the Documentation that is most current at the Product Effective
Date. BMC’s entire liability and your exclusive remedy under this provision will be for BMC to use reasonable best efforts to remedy
defects covered by this warranty and condition within a reasonable period of time or, at BMC’s option, either to replace the defective
Product or to refund the amount paid by You to license the use of the Product. BMC and its suppliers do not warrant that the Product
will satisfy your requirements, that the operation of the Product will be uninterrupted or error free, or that all software defects can be
corrected. This warranty and condition shall not apply if: (i) the Product is not used in accordance with BMC’s instructions, (ii) a Product
defect has been caused by any of your or a third party’s malfunctioning equipment, (iii) any other cause within your control causes the
Product to malfunction, or (iv) You have made modifications to the Product not expressly authorized in writing by BMC. No employee,
agent or representative of BMC has authority to bind BMC to any oral representations, warranties or conditions concerning the Product.
THIS WARRANTY AND CONDITION IS IN LIEU OF ALL OTHER WARRANTIES AND CONDITIONS. THERE ARE NO OTHER
EXPRESS OR IMPLIED WARRANTIES OR CONDITIONS, INCLUDING THOSE OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, REGARDING THIS LICENSE OR ANY PRODUCT LICENSED HEREUNDER. THIS PARAGRAPH
SHALL NOT APPLY TO A TRIAL LICENSE. Additional support and maintenance may be available for an additional charge; contact
BMC or your BMC reseller for details.

LIMITATION OF LIABILITY. Except as stated in the next succeeding paragraph, BMC’s and your BMC reseller’s total liability for all
damages in connection with this License is limited to the price paid for the License. IN NO EVENT SHALL BMC BE LIABLE FOR ANY
CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE USE OF
THIS PRODUCT (SUCH AS LOSS OF PROFITS, GOODWILL, BUSINESS, DATA OR COMPUTER TIME, OR THE COSTS OF
RECREATING LOST DATA), EVEN IF BMC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some jurisdictions
do not permit the limitation of consequential damages so the above limitation may not apply.

INDEMNIFICATION FOR INFRINGEMENT. BMC will defend or settle, at its own expense, any claim against You by a third party
asserting that your use of the Product within the scope of this License violates such third party’s patent, copyright, trademark, trade
secret or other proprietary rights, and will indemnify You against any damages finally awarded against You arising out of such claim.
However, You must promptly notify BMC in writing after first receiving notice of any such claim, and BMC will have sole control of the
defense of any action and all negotiations for its settlement or compromise, with your reasonable assistance. BMC will not be liable for
any costs or expenditures incurred by You without BMC’s prior written consent. If an order is obtained against your use of the Product
by reason of any claimed infringement, or if in BMC’s opinion the Product is likely to become the subject of such a claim, BMC will at its
option and expense either (i) procure for You the right to continue using the product, or (ii) modify or replace the Product with a
compatible, functionally equivalent, non-infringing Product, or (iii) if neither (i) nor (ii) is practicable, issue to You a pro-rata refund of
your paid license fee(s) proportionate to the number of months remaining in the 36 month period following the Product Effective Date.
This paragraph sets forth your only remedies and the total liability to You of BMC, its resellers and licensors arising out of such claims.

GENERAL. This License is the entire understanding between You and BMC concerning this License and may be modified only in a
mutually signed writing between You and BMC. If any part of it is invalid or unenforceable, that part will be construed, limited, modified,
or, severed so as to eliminate its invalidity or unenforceability. This License will be governed by and interpreted under the laws of the
jurisdiction named below, without regard to conflicts of law principles, depending on which BMC Software, Inc. subsidiary is the party to
this License: (i) BMC Software Distribution, Inc. - the State of Texas, U.S.A., (ii) BMC Software Distribution, B.V. - The Netherlands, (iii)
BMC Software Asia Pacific Pte Ltd. -- Singapore (iv) BMC Software do Brazil -- Brazil, or (v) BMC Software K.K. -- Japan. Any person
who accepts or signs changes to the terms of this License promises that they have read and understood these terms, that they have
the authority to accept on your behalf and legally obligate You to this License. Under local law and treaties, the restrictions and
limitations of this License may not apply to You; You may have other rights and remedies, and be subject to other restrictions and
limitations.

U.S. GOVERNMENT RESTRICTED RIGHTS. UNPUBLISHED -- RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE
UNITED STATES. Use, duplication, or disclosure by the U.S. Government is subject to restrictions set forth in FAR Section 52.227-14
Alt. III (g)(3), FAR Section 52.227-19, DFARS 252.227-7014 (b) or DFARS 227.7202, as amended from time to time.
Contractor/Manufacturer is BMC Software, Inc., 2101 CityWest Blvd., Houston, TX 77042-2827, USA. Any contract notices should be
sent to this address.
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